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1. Introduction

1.1. Description of the gas analyser

The KIGAZ 210 is a flue gas analyser with two interchangeable sensors (long-life O, and CO-H,), with additional possibility of a 3™
sensor (NO or CH,) or is a flue gas analyser with three interchangeable sensors (long-life O,, CO-H, and NO) with additional
possibility of a 4" sensor (CHa).
Its main features are the following:

*  Auto-zero in the duct
Protection of CO sensor by solenoid valve
Led on handle for lightning of dark areas
External water trap
LCD screen: 120 x 160 pixels, 50 x 67 mm
Integrated printer
2 thermocouple connections

* 2 Go of memory
The gas analyser is supplied in a transport case in ABS or metallic (optional) with a magnetic protective cover, a differential pressure
kit, an interchangeable flue gas probe of 300 mm length with integrated draft and LED, a Li-ion battery and its charger, LIGAZ-2
software, an USB cable and a calibration certificate. A paper roll for the printer and a filter are also provided.

This analyser is designed to control parameters of flue gas in exhaust duct or heating units. It can not be used in a
permanently way and/or used as an alarm system.

1.1.1. Overview of the analyser

Integrated printer

Handle

LCD screen

LED button

LED

Fixing cone

—— External water trap

Differential pressure

Single connector for flue
plug

gas probe (TcK+gas) and
draft

Flue gas probe
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1.1.2. Presentation of the keypad and screen

Measurements menu

Customers menu

Setting menu

Procedures menu

Information menu

Home screen

Function keys

OK button Directional arrows

ESC button ON/OFF button

KIGAZ 210

1.1.3. Connection of the analyser

C1 connection for external probes
(Pt100 temperature, CH,,...) Flue gas probe connection

Light for battery
charging

Power supply—

O) Gas outlet

T1and T2 P- pressure tap
thermocouple
connections P+ pressure tap
Top view Bottom view Right side view

USB
connection

Introduction



1.2. Main features

* Screen
LCD screen, 120 x 160 pixels, 50 x 67 mm. It allows to display the measured parameters in a comfortable format for the user. With the
zoom function, the measured values can be visualised in increased characters.

*  Printer
The printer has 10-year guarantee thermal paper. The printer has an easy replacement system of the paper (Easyload). In addition,
printing is fast.

» Batteries charger
The instrument is supplied with a 6 V, 1.5 A power adapter to load the internal batteries. The current loading is indicated by a battery
symbol on the top left of the screen. The red LED on the right side of the gas analyser stays on until the battery loading is completed.
The battery charging time is 10 hours. The voltage of power supply is 100-240 VAC, 50/60 Hz. The number of cycles of the battery is
about 500 charging cycles.

*  Flue gas suction pump
The pump, inside the gas analyser, is a diaphragm pump with a motor. It is energized in direct current directly by the instrument in a
way to get an optimal suction of flue gases.

*  Flue gas probe
Probe in stainless steel with a handle in ABS and a standard length of 30 cm (other probes are available as option, see the technical
datasheet of accessories for KIGAZ), with a fixing cone to maintain the contact tip in the duct. Interchangeable, its LED allows to light
dark areas. It is connected to the instrument with a neoprene tube of 2.50 m.

* Interchangeable measurements sensors
The analyser uses electrochemical sensors to measure the oxygen and the carbon monoxide (compensated in H, hydrogen). The
measurement sensors are interchangeable.

*  Temperature sensors
Flue gas temperature is measured with a thermocouple integrated in the contact tip. The connection to the analyser is made thanks to
a single male connector compensated in temperature. K thermocouple (nickel-nickel chromium) allows continuous measurements up
to 1250 °C.
The instrument has a NTC thermoresistance for the measurement of internal temperature; this sensor is also used for the
measurement of ambient temperature.
If a temperature control of the combustive air must be performed directly by the supply duct (room sealed boiler), a Pt100 temperature
probe (ref: SPA 150 SP) will be used. It is recommended to perform this measurement to make the efficiency calculation of the
installation more accurately.

*  Pressure sensor
The analyser has one internal piezoelectric sensor for the measurement of the differential pressure (Delta P) with manual autozero.

e Supply input of flue gases and +/- pressure
The analyser has a single connector allowing the connection of a flue gas probe.

* Types of combustibles
The analyser is supplied with a memorization of technical data which characterize the 15 most known combustibles. It is also possible
to add 5 combustibles and their corresponding features.

» Calibration certificate
The analyser is calibrated by comparison with standard of metrology laboratories, which are periodically certified closed to laboratories
known at the international level. Each analyser is supplied with its calibration certificate in which, for every parameters, are indicated
the nominal value, the one measured, the admitted error limits and the found error.

*  EMC compatibility
The analyser complies with n°2004/108/EC directive on electromagnetic compatibility. Document available on request.

»  Conformity
The analyser complies with the EN 50739-1 and 2 standard.
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e Water trap
The water trap is placed on the tube that links the flue gas probe to the KIGAZ 210. The measured gases go through the filtering
element allowing the recovery of condensates (liquid one or solid one).
The filtering element is placed 15 cm from the analyser and is divided into 2 parts:
one recovers the liquid particles.
the other contains a filter that stops the smallest particles in suspension and avoid them to reach the electro-chemical sensors

e ™
For a better measurement, the water trap must be in
vertical position. C.hECk that both ends are well b In case of water presence, do not
clipped to ensure a good d forget to empty it after each use
Empty and clean the mater trap after use. waterproofness ==
4
i 8
.« Lower plug
N J
¢ Auto-zero

The analyser has the “auto-zero in the duct” function, it means that the operator can perform measurements (draft, temperature...)
while the analyser inhales fresh air in the room. This function allows to save time on the inspection location.

*  Protection by solenoid valve
The analyser is equipped with the CO protection function that allows to avoid high concentrations of CO that could damage the
analyser and the sensors. The CO measurement is stopped when it exceeds 2000 ppm (default configuration of the threshold and
adjustable by the operator). All the measurements stay possible unless the CO measurement.

*  Customers, boilers and inspections management
The analyser allows to record customers, theirs respective boilers and inspections. Once the features of customers and boilers are
completed in the analyser, the operator can easily assign the different measured values to a customer and his boiler.

*  Opacity index measurement (optional)
It is possible to fill in the analyser with opacity index values measured according to the Bacharach scale. The analyser will calculate the
average and results will be printed on the ticket. This measurement must be performed with an opacity pump which is available as an
accessory (ref: PMO).

* Gas flow
It is possible to measure the gas flow of an installation, to compare it with a theoretical gas flow and as a result to estimate the
installation consumption.

*  Gas network leak testing (optional)
It is possible to check the tightness of an installation. For this control, use the pressure sensor used for the differential pressure
measurement of the shaft (ref.: KEG).

* Measured values
- 0,: percentage of oxygen in flue gases
- CO: concentration of CO in flue gases
- NO: concentration of NO in flue gases
- Tf: flue gases temperature
- Ta: combustive air temperature

» Calculated values
- A: Air Excess : connection between the volume of combustive air and the requested volume necessary for a combustion in
stoichiometric conditions.
- CO.: percentage of carbon dioxide in flue gases.
- AT: difference between the flue gases temperature and the combustive air temperature.
- NOx: concentration of NOx in flue gases (calculated with the NO sensor, or measured with the NO and NO, sensors)
- Qs: percentage of waste heat throughout the shaft.
- ns: Lower efficiency (or sensible): calculated burner efficiency. This is a ratio between the conventional heating power end
the burner heating power. Among the combustion losses, only the sensible heat lost with the flue gases is taken into account,
neglecting the radiation losses and incomplete combustion losses. This value is referred to LHV (Lower Heating Value) and
can not be higher than 100%.
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The sensible efficiency value is to be compared with the minimum efficiency stated for the heating systems performances.

- nt: Higher efficiency (or total): is the sum of sensible efficiency and the additional efficiency deriving from the recovery of
water vapour condensation contained in the flue gases. When it s greater than sensible efficiency, then condensation is taking
place. It is referred to LHV (Lower Heating Value) and can exceed 100%. The LHV is calculated by an algorithm developed by
Kimo and its value must be considered as indicative.

- CO (0,): Concentration of CO in flue gases in mg/m®. It is calculated according to O, reference value indicated in the
analyser (see page 21).
- NO (0,): Concentration of NO in flue gases in mg/m®. It is calculated according to O reference value indicated in the
analyser (see page 21).

- NOx (O): Concentration of NOx in flue gases in mg/m”. It is calculated according to O, reference value indicated in the
analyser (see page 21).
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1.3. Technical features

T90
Parameter Sensor Measuring range Resolution Accuracy* response
time
Long-life O, Electro-chemical  |From 0 % to 21 % 0.1 % vol. £0.2 % vol. 30s
From 0 to 200 ppm: £10 ppm
co From 201 to 2000 ppm:
(with H, Electro-chemical  |From 0 to 8000 ppm 1 ppm 5% of measured value 30s
compensation) From 2001 to 8000 ppm:
110% of measured value
From 0 to 100 ppm: £5 ppm.
NO Electro-chemical  |From 0 to 5000 ppm 1 ppm From 101 to 5000 ppm: 30s
+5% of measured value
From 0 to 100 ppm: £2 ppm
Low range NO Electrochemical  |From 0 to 500 ppm 0.1 ppm From 101 to 500 ppm: 30s
12 % of the measured value
NOx Calculated** From 0 to 5155 ppm 1 ppm - -
c0o2 Calculated™* From 0 to 99 % vol 0.1 % vol - -
From 0 to 10000 ppm 1 ppm
CH, Semiconductor From 0to 1 % Vol 0.0001 % Vol |£20 % of full scale 40s
From 0 to 20 % LEL 0.002 % LEL
Flue gas K thermocouple  |From 100 to #1250 °C (0.1 °C +0.4 % of measured value or +11 °C | 45
temperature
Ambient ntemalNTC ~ From-20104120°C  01°C  #05°C
temperature
Ambient PHOO(SDIN e s0to 4250°C  (0.1°C +0.3 % of measured value £0.25°C | 305
temperature external probe)
Dew point |1 ated™ From010+99°Ctd  0.1°C i :
temperature
DHW TeK (external From -200 to +1300 °C  |0.1 °C 10.4 % of measured value or +1.1 °C -
temperature probe)
From -20 000 to -751 Pa:
Differential From -20 000 1Pa 10.5 % of measured value +4.5 Pa
pressure to +20 000 Pa From 750 to -61 Pa:
+0.9% of measured value £1.5 Pa
Piezoelectric From -60 to 60 Pa: +2 Pa -
From 61 to 750 Pa:
Draft Erom 1838 :181%%0 P (1); Pa +0.9% of measured value £1.5 Pa
fom -1LLo 10 a|lra From 751 to 20 000 Pa:
+0.5% of measured value +4.5 Pa
Losses Calculated™™* From 0 to 100% 0.1% - -
Flue gas Calculated™™* From 0 to 99.9 m/s 0.1 m/s - -
velocity
Excess air (\) | Calculated™ From 10 9.99 0.01 - -
Efficiency (ns) |Calculated™ From 0 to 100 % 0.1% - -
Efficiency (1) | aicuiated  |From 010120 % 0.1% : :

(condensation)

Opacity index

External instrument

FromOto 9

* All accuracies indicated in this document were stated in laboratory conditions and can be guaranteed for measurements carried out in the same conditions, or carried out with required

compensation.

** Calculation is made based on the measured values by the analyser.
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2. Safety

2.1. Precautions for use

Please always use the device in accordance with its intended use and within parameters described in the technical features
in order not to compromise the protection ensured by the device.

2.2. Symbols used

For your safety and in order to avoid any damage of the device, please follow the procedure
described in this user manual and read carefully the notes preceded by the following symbol:

The following symbol will also be used in this user manual: @
Please read carefully the information notes indicated after this symbol.

2.3. Safety instructions

The following safety instructions have to be strictly observed. A
Not respecting these safety instructions can lead to a loss of warranty.
« The analyser should not to be used in and under water.

» The analyser should not to be placed near or directly at open fire or heat.

« The indicated range of temperature of the probe is not to be exceeded, as the probe and temperature
sensor could be destroyed.

» After measurements, before packing the analyser, wait for the probe to be cold. As long as it is hot, the
probe could cause injuries.

» The exhalations of alcohol liquids (lubricants, petrol, spirit, vanish...) may damage the sensors of the
analyser. Therefore, it is forbidden to preserve or use these fluids nearby the analyser.

» Load the battery only with Kimo charger. The charger must be used only for the power supply loading. Use
another type of charger can damage the battery and the analyser and can cause electrical shocks.
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3. Perform a flue gas analysis

3.1. Prepare the instrument before the analysis

During the measurement, the analyser must be in vertical position or in horizontal position. Do not hold the

analyser in inclined position.

A Before the 1% use of the analyser, a full charge of the battery must be made during 12 hours.

A Empty the water trap.

In case of any default or damage of the instrument, Kimo After sales service shall be contacted. On the
back of the analyser, there is a label with the analyser serial number. This number shall be communicated

for every operation (technical operation or request of spare parts).

3.2. Perform an analysis

» Connect the flue gas probe to the analyser. 40
> Turn on the instrument. Connecting
Home screen is displayed with measurement menu highlighted. flue pipe Probe
» Insert the probe in the flue as show on the figure for at least 3 minutes. 2D
» Press OK.
The screen with the different possible measurements is displayed.
Remaining time of auto-zero and its progress bar are displayed at the bottom of
the screen.
Measurements covered by the auto-zero are not available (Combustion, Max CO and | BE——=o
) , E———
ambient CO,). At the end of the auto-zero, these menus are available. e —
Take advantage of the auto-zero to perform the draft. E——
» Go to “Flue gas” with the up and down arrows.
» Press OK. O
The screen displays the different combustibles in the analyser.
» Select the type of used combustible by the boiler with the up and down arrows.
» Press OK.
The screen displays values of the different parameters of the analysis. Perform measurement for at least 3 minutes.
- Measurements Measurements
& &
. KIGAZ 210 > °= -
Inaccessible measurements Auto-zero

during the auto-zero

Sahara/Fos Nat. Gas Flue gas Measurements
' Tf

A 33 °C 402
co ns Groninguen Nat. Gas
ppm 0 % 94 @ Russia Nat. Gas °
gﬂoz 99 'o}: o7 ~ Propane -
Ta 281 NOx (O,) O LPG
o A

Press the “Hold” il -

function button to hold A 123 & a8 ]
v
the measurement.
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3.3. Zoom function

From the gas analysis screen, the zoom function is available using the direction arrows.
The initial screen displays 12 measured values.

» To zoom in, press the right arrow.
The screen displays 6 measured values.
» To zoom in again, press the right arrow.
The screen displays 3 measured values.
» To zoom in again, press the right arrow.
The screen displays one measured value.
» To zoom out, press the left arrow.
» Atany time, press the down arrow to scroll the values.
Sahara/Fos Nat. Gas Sahara/Fos Nat. Gas Sahara/Fos Nat. Gas Sahara/Fos Nat. Gas
s 33% 402 % 33 o,
w  or wms|lg (@ 0 | |% 33 ¢ 0.
5 99 % o7 & 99 = 33
0
I 281 px® 0 Iz 281 co 0 /o
as ppm
A 123 5 08B A 123
v v v v
Save Print Hold Save Print Hold Save Print Hold Save Print Hold

Sahara/Fos Nat. Gas
co 0
ppm
Cco
2 a9
%
v
Save Print Hold

3.4. Assign the analysis to a customer

» Atthe end of the analysis, when measurements are constant, it is possible to assign it to a customer recorded in the analyser
or to unrecorded customer that should be created.
» Press the “Save” function button.
The analyser displays the list of recorded customers.
» Select a customer with up and down arrows then press OK or create a customer (see page 23) then select it.
The analyser displays the list of available boilers.
» Select the boiler with up and down arrows then press OK or create a boiler (see page 24) then select it.
The analyser backs to the measurement screen of the analysis.

3.5. Add the measurement to a group

The groups allow to regroup measurements in folders. The group function has to be activated (see page 18).
Once the measurement is linked to a customer and a boiler, it is possible to add it in a group in the instrument, or create a group:
The analyser proposes to add the measurement to a group.
» Goto YES and press OK.
» Go to the required group with the arrows and press OK, or create a group (see page 25).
The analyser backs to the measurement screen.

3.6. Print the analysis results

It is possible to print the results on the ticket:
» Press the “Print” function button.
Results are printed on the ticket.
See page 17 for the printing configuration.
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4. Perform a quick measurement

The quick measurement allows to perform in a few seconds:
* aflue gas measurement
* adraft measurement
* and an ambient CO measurement with Max CO.
» During the quick measurement, it is possible to print a ticket at each step by pressing the “Print” function button, or print the
whole measurements when the analyser proposes it at the end of the quick measurement (screen 13).

= o R - i I - T
- Measurement Measurement
KIMO
INSTRUMENTS INSTRUMENTS ﬁ
v 1 ‘
’ KIGAZ 210 - I - -
Y
L
o
Soft version: 1.253
Serial num.: 21541-554-254-454 DFZD Auto-zero Remammg}g:sn:(
Screen 1 Screen 2 Mesurements not accessible SCreen 3 Autozero  Screen 4 @
during the auto-zero
E
Max CO Draft pressure Sahara/Fos Nat. gas Flue gas analysis
o b 402
Amb. CO measurement % 33 ¢ ’ Groni
roninguen Nat. gas
Probe? co o ns
Next Pr Next | ppm % 9 e Russia/NsN Nat. gas
- Pa ' = 3-0 - %0: 99 ;}: 1071 ~ Propane
Ié 281 ygﬁ(oz) 0 LPG
Butane
External i A 123 & 08
Next Print Purge Next Print Hold _
Screen 8* @ Screen 7 Or 'Purge” to perform Screen 8 Screen 5
adigital auto-zero
Max CO Max CO Max CO Max CO
Max CO - - - Max CO
Take out probe Auto-zero ppm ppm O
of duct ° e
> p| Duration: 30 sec »| CO D
ppm
- Press OK Duration: 29 sec
to Start
|
Screen 9 Screen 10 Screen 11 Or "Duration’ to set the Screen 12 @
measurement duration
Max CO Max CO Max CO
Cut the ticket Printing... Quick measurement complete
Print again? A@ Quick measurement ° Print?
]
Screen 15 Screen 14 Screen 13

* If the CO SCOT probe is used, select “External” then follow the instructions on the analyser.
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5. Set the different parameters of the analyser

The “Setting” menu allows to set the following parameters :
 Instrument (screen, printing, auto-off,...)
Combustibles
Measurement
References (O,, atmospheric pressure and altitude)
Auto-zero/Purge
Operators
The “Setting” part allows to set parameters that can affect the performed measurements. These settings must be
made by a qualified technician.

5.1. Instrument setting '!‘

5.1.1. Screen setting

This part allows to set the backlight of the screen from 1 to 9.

» Turn on the instrument.
Home screen is displayed with measurement menu highlighted.
Go to “Setting” with the up and down arrows then press OK.
Go to “Instrument” then press OK.
Press OK on the “Screen” line.
Go to “Backlight” then press OK.
Use the up and down arrows to increase or decrease the value.
Press OK to validate.

5.1.2. Set the auto-off

The auto-off allows to turn off the analyser automatically after some time of non-use.
It is possible to set the auto-off at 15/30 /45 /60 /90 or 105 minutes or to deactivate it.
“Setting > Instrument” screen is displayed.
» Go to “Auto-off” with the up and down arrows then press OK.
» Select the required time of auto-off or “OFF” to deactivate it with the up and down arrows.
» Press OK to validate.

5.1.3. Change the language

It is possible to select the language of the instrument: French or English in standard. A third language is downloadable through the
LIGAZ-2 software.
“Setting > Instrument” screen is displayed.
» Go to “Language” with the keypad then press OK.
» Select the language with the keypad.
» Press OK.

5.1.4. Modify date and time

“Setting > Instrument” screen is displayed.

Go to “Date/time” with the keypad then press OK.

Go to the parameter to modify with the keypad (day, month, year, hour, minute or second).

Press OK.

Use the up and down arrows to modify the selected parameter.

Press OK.

Repeat the procedure on another parameter if required.

Go to “Date Format” with the keypad then press OK.

Select « Day/Month » to display the day then the month or “Month/Day” to display the month then the day then press OK.
Go to “Time Format” with the keypad then press OK.

Select the time format: “12” or “24”.

If 12 is selected, “AM” for ante meridiem or « PM » for post meridiem will be displayed in front of the time.
Press the “OK” function key to quit the screen and save the modifications or press Esc to cancel.

VVVVVY
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5.1.5. Ticket printing setting

“Setting > Instrument” screen is displayed.
» Go to “Printing” with the keypad then press OK.
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» Go to “Format” with the keypad then press OK.

» Select the ticket format: long or short with the keypad then press OK.
Long ticket format: prints the headers, the user name, the ~ Short ticket format: prints only the device reference, the
type of device and its serial number, the customer and the type of combustible, the date and time and the measurement
selected boiler, the type of combustible, the inspection date  results.
and time and the measurements results.

KIGAZ 210
— & serial num
(KIMO' SC 150699999
Lol et e
INSTRAUMENTS
Enti.ﬂ.i 1 Combust. :
Entéte 2 Sahara/Fos Nat. gas
Entéte 3
Entéte & Date : 08712/2015
Time : 15 21:07
op 1
Measured values
e e i 02 3.0 %
co 0 ppm
RIGAZ 210 Amb. T 25.3 °C
Serial nue Gas T P B
SC 180699099
Combust. :
Sahara/Fos Hat. gas Calculated values
Date : 08/12/2015
Time ; 15 21:07 coz 11.9 %
Alr exc 1.00
Diff. T 24.8 °C
Measured values Low EFF, 99.0 4
0 %
High Eff 104.1 %
02 3.0 % Loases 1.0 %
co 0 ppm N 0
Amb. T 25.3 °C 2R
Gas T S0.1 “C

Calculated values

oz 11.9 %
ALr exc 1.00
Difd. T 24.8 ¢
Low EfF, 99.0 %
High Eff 104.1 %
Losses 1.0 %
NOx 0 ppn
Dew poimt 58.8 “cC
cosooz 0.00 %
uCl 0.0

€0 (02) e
NO (02) e
NOx{ 02 ) O ppm
02 ref 21.0 %

Go to “Logo” then press OK to activate it: ON or deactivate it: OFF.

Go to the first line of the “Header” then press OK.

The keyboard appears at the bottom of the screen.

Select the letters with the keypad then press OK.

Press the “OK” function key to validate the line.

The keyboard disappears.

Press Esc to back to “Setting instrument” screen and validate modifications.

To go from lower-case keyboard to upper-case keyboard then to numeric keyboard: press the “A a 1” function key.
* Toerase a letter: press the “Delete” function key.

*Y VV VYV

5.1.6. Activate or deactivate the visual support

The visual support corresponds to help windows displayed met during a measurement procedure.
“Setting > Instrument” screen is displayed.
» Go to “Support” with the keypad.
» Go to “Visual support” line with the keypad.
» Press OK to activate it: ON or to deactivate it: OFF.

5.1.7. Activate the group function

Groups allow to gather measurements in a folder. To activate it:
“Setting > Instrument” screen is displayed.
» Go to “Group” with the keypad.
» Press OK to activate it: ON or to deactivate it: OFF.
For the groups creation and management, see page 25.
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5.1.8. Select the alarm sound

“Setting > Instrument” screen is displayed.
» Go to “Audio” with the keypad then press OK.
» Press again OK
» Select with the keypad the Alarm 1 sound or the Alarm 2 sound then press OK.

5.1.9. Activate or deactivate Bluetooth® function (optional)

Bluetooth® allows to set and transfer data from a computer to the analyser or vice versa.
“Setting > Instrument” screen is displayed.
» Go to “Bluetooth” with the keypad.
» Press OK to activate it: ON or to deactivate it: OFF.

The * icon appears on the instrument screen when it is activated.

When Bluetooth® is activated, Kigaz appears with the name “Kigaz” in the available devices list of the computer, tablet or
smartphone.

5.2. Set the combustible u

15 different combustibles are recorded in the analyser:

Sahara / Fos Natural gas Cannel-coal
Groninguen — Natural gas Low volatile coal
Russia — Natural gas Coke gas
Propane Biofuel 5%

LPG Wood 20%
Butane Hog fuel 21%
Light oil Pellet 8%

Heavy fuel ail

5.2.1. Modify a combustible
Each combustible has its own coefficient allowing to calculate losses and efficiencies in the most accurate way.

The modification of these coefficients will lead some modifications in combustion analysis results. Only a
qualified technician is authorized to modify them.

It is still possible to reset the factory parameters pressing the “Factory parameters” function key or with the
LIGAZ-2 software (see page 55).

“Setting” screen is displayed.

Go to “Combustibles” with the arrows then press OK.

Go to the required combustible with the up and down arrows then press OK.

Go to the coefficient to modify with the up and down arrows then press OK.

The keyboard is displayed.

Select the numbers with the arrows and press OK to validate.

The analyser backs to the combustibles list.

To go from lower-case keyboard to upper-case keyboard then to numeric keyboard: press the “A a 1” function key.
To erase a letter: press the “Delete” function key.

YV VYVV

Itis also possible to modify the name of a combustible and its type of energy (solid, liquid or gas):
“Setting > Combustibles” screen is displayed.

Go to the combustible to modify with the up and down arrows then press OK.
Press the “Modify” function button.

Press OK on the “Name” line.

The keyboard appeatrs.

Select the letters with the direction arrows and press OK to validate.

Press the “OK” function key to validate the new combustible name.

Press OK on the “Energy” line.

Select the combustible energy type: solid, liquid or gas and press OK.

Press the “Save” function key.

The instrument backs to the combustible list with the modifications applied.

VVVVY VYV
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5.2.2. Add a combustible

Up to 5 combustibles can be added in the instrument's memory:

>

VVVVYVY 'V

A\

>
>

“Setting > Combustibles” screen is displayed.

Press the “Add” function key.

“Add combustible” screen is displayed.

Press OK.

The keyboard appears.

Enter the name of the combustible with the keypad and press OK.

Press the “OK” function key to validate the name of the new combustible.

Go to “Energy” line with the keypad and press OK.

Select “Solid”, “Liquid” or “Gas” with the keypad and press OK.

Press the “Save” function key to save the new combustible.

Screen backs to the list of combustible. The new combustible in well on the list in last position.
Every coefficient of the new combustible is set at 0.

Follow the procedure of modification of combustible coefficients described page 19.

5.2.3. Delete a combustible

“Setting > Combustibles” screen is displayed.
Go to the combustible to delete with the keypad.
Press the “Delete” function key.

5.3. Set the alarms, measurement units and CO protection P 'Y

It is possible to activate an alarm for each measurement parameter. This alarm can be rising (the alarm of the instrument is activated
when the measured value exceeds the defined threshold) or falling (the alarm of the instrument is activated when the measured value
is below the defined threshold).

It is possible to set an alarm for the following parameters:

0,, CO, Amb. CO, CH,, CO,, Qs (losses), A (excess air), nt (lower efficiency), ns (higher efficiency), Tf (flue gas temperature),

Ta (ambient temperature), Td (dew-point temperature), Pr. (pressure), AP (differential pressure), draft.

YV V

>

5.3.1. Set the alarms

“Setting” menu is displayed.

Go to “Measurement” with the keypad then press OK.

Press OK on “Alarms” line.

Go to the parameter to modify with the keypad then press the “Modify” function key.
The edge (rising or falling) and the threshold of the selected parameter are displayed.
Go to the “Edge” line with the keypad then press OK.

Select the type of alarm with the keypad:

VVVY VYV

+ Risingedge: A 4

* Falingedge: A ¥

«  Deactivated alarm: & %

Press OK.

Go to the “Threshold” line then press OK

The keyboard appears.

Enter the alarm threshold value with the keypad and press OK to validate.
Validate the threshold with the “OK” function key.

Validate the modifications with the “Save” function key.

Press Esc to quit the screen.

5.3.2. Set the measurement units

It is also possible to select the measurement unit for each measured parameter:

YV VVYV

Temperature: °C, °F

Pressure: Pa, inWg, hPa, mbar, mmHg, mmH,0, PSI
CO/CO;/NO/NOx: ppm, mg/m®, mg/kWh, g/kWh, g/GJ, g/m?, %
CHa: ppm, %vol, %LIE

“Setting” menu is displayed.

Go to “Measurement” with the keypad then press OK.

Go to “Units” with the keypad then press OK

Go to the parameter to modify with the keypad then press OK.

The list of the available units according to the parameter appears.
Go to the requested unit with the keypad then press OK.

20
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» Press Esc to quit the screen.
5.3.3. Set the CO protection threshold

The CO protection allows to protect the instrument against high concentrations of CO. Above the protection threshold, the instrument

will stop the CO dilution by pump stopping but the other measurements are still possible. To set this threshold:
“Setting” menu is displayed.

Go to “Measurement” with the keypad then press OK.

Go to “CO protection” with the keypad then press OK.

Press the “Modify” function key to modify the threshold.

Enter the requested threshold then press the “OK?” function key to validate the threshold.

Press Esc to quit the screen.

5.3.4. Set the display

“Setting” menu is displayed.

Got to “Measurement” with the keypad then press OK.

Go to “Display” with the keypad then press OK.

Press the “Viewable” function key to activate or deactivate the measurement display.
Press the “OK” function key to validate.

YVVVYY

VVVY

5.4. Set the references

The “Setting > References” screen allows to set the features of the measurement environment: O, reference, %NO; (for the Nox
calculation), altitude and atmospheric pressure. These data are used to calculate the efficiency.

A These setting must be performed by a qualified technician.

“Setting” menu is displayed.
> Go to “References” with the keypad then press OK.
» Select the parameter to modify with the keypad then press OK.
The keyboard appears.
» Enter the parameter value with the keypad then press OK to validate. .

5.5. Set the duration of auto-zero and purge time

The auto-zero allows the analyser to exhaust ambient fresh air and as a result to put the sensors at 0 ppm.
“Setting” screen is displayed.
» Go to “AutoZ/Purge” line with the keypad then press OK.
» Press OK.
The list of available duration appears.
» Go to the required duration then press OK.
» Press Esc to quit the screen.

5.6. Set the operators f./!.

It is possible to enter in the analyser names of operators who will use the instrument. The operator who performs an analysis appears

on the ticket (only for the long size format).
5.6.1. Add an operator

“Setting” screen is displayed.

Go to “Operator” with the keypad then press OK.

Press the “Add” function key.

The keyboard appears.

Enter the name with the keypad: press OK to validate.

Press the “OK” function key to validate the operator name and to add it in the list.
The analyser backs to the list of present operators.

Press Esc to quit the screen.

YV VYV VYV

5.6.2. Modify the operator name

“Setting” screen is displayed.

Go to “Operator” with the keypad then press OK.
Press the “Modify” function key.

The keyboard appeatrs.

\ 274
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> Modify the name with the keypad: press OK to validate.

» Press the “OK” function key to validate the operator name.
The analyser backs to the list of current operators.

Press Esc to quit the screen.

\4

5.6.3. Delete an operator

“Setting” screen is displayed.

Go to “Operator” with the keypad then press OK.
Go to the operator to delete with the keypad.
Press the “Delete” function key.

Press Esc to quit the screen.

VVVY

5.7. Back to factory setting of the analyser

It is possible to set the analyser with its factory setting.
“Setting > Instrument” screen is displayed.
» Press the “Factory setting” function key.
A message is displayed and asks to confirm the return to factory settings.
» Go to “OK” with the keypad then press OK.
» Press Esc or go to “Cancel” with the keypad then press OK.

5.7.1. Units and values of measurement settings of the factory setting

Temperature: °C
Draft: Pa
Differential pressure: mbar
CO: ppm
COx: %
NO: ppm
NOx: ppm
CHa: ppm
CO (0,): mg/m?
NO (0): mg/m®
NOXx (O2): mg/m*
Alarm thresholds:
e 0x30%
CO: 100 ppm
Amb. CO: 10 ppm
CHs: 1200 ppm
Air excess (A): 1.10
Flue gas temperature (Tf): 250.0 °C
Reference:
° 02: 21.0 %
+  Altitude: 800 m
*  Atmospheric pressure: 1013.25 hPa
CO protection threshold: 2000 ppm
Auto-zero and purge duration: 1 minute

Created operators and combustibles will be deleted. Created customers, boilers and inspections on boilers are not
deleted after a return to factory setting.

5.7.2. Device factory setting

Back-light: 7

Auto-off: 15 minutes

Language: French

Print: long ticket, logo display deactivated and empty headers
Visual help: ON (activated)

Alarm audio parameter: Alarm 1

Groups: OFF (deactivated)

Bluetooth (option): deactivated
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6. Manage customers m

It is possible to save names and addresses of different customers in the analyser. The performed measurements could be
assigned to them. It is possible to create up to 250 customers.

6.1. Manage a customer

Turn on the analyser.

Go to “Customers” with the keypad then OK.

Press the “Add” function key.

“Add customer” screen is displayed.

Press OK on “Name” line.

The keyboard appeatrs.

Enter the customer name with the keypad and press OK to validate the letters.

Press the “OK” function key.

The analyser backs to “Add customer” screen.

Go to the 1 line of the address with the keypad then press OK.

Enter the 1% line of the customer's address with the keypad and press OK to validate letters.
Press the “OK” function key.

The analyser backs to “Add customer” screen.

Go to the 2" line of the address with the keypad then press OK.

Enter the 2 line of the customer's address with the keypad and press OK to validate letters.
Press the “OK” function key.

The analyser backs to “Add customer” screen.

Continue for both following lines of the address if necessary.

Go to “Phone” line with the keypad then press OK.

Enter customer's telephone number with the keypad and press OK to validate the numbers.
Press the “Save” function key.

The analyser backs to “Customer List” screen with the created new customer.
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When a customer has been created, it is possible to link to this customer one or several boilers. See page 24 to create, modify and
delete a boiler.

6.2. Modify a customer

“Customers” screen is displayed.

Go to the customer to modify with the keypad then press OK.
Press the “Detail” function key.

Details of the customer are displayed.

Press the “Modify” function key.

Go to the line to modify with the keypad then press OK.

The keyboard appears.

Make the changes.

Press the “Save” function key to validate.

The analyser backs to “Customer detail” screen.

Press the “Save” function key once all the changes have been made.

vV VYV VV VYV

6.3. Delete a customer

“Customer” screen is displayed.

Go to the customer to delete with the keypad then press OK.
Press the “Delete” function key.

A message appears asking to confirm the deletion of the customer.
Go to YES then press OK to confirm the deletion.

Go to NO then press OK to cancel.

VV VYV
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7. Manage boilers

Aboiler is compulsorily linked to a customer, at least one customer must be created to create a boiler. See page 23 for the creation of a
customer. It is possible to link up to 10 boilers per customer.

7.1. Create a boiler
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The list of customers saved in the analyser is displayed.

Go to the customer which will be linked to the boiler with the keypad then press OK.

Press the “Add” function key.

Press OK on “Model” line.

The keyboard appears.

Enter the model of the boiler with the keypad then press OK to validate the letters.

Press the “OK” function key to validate the model.

The analyser backs to “Add boilers” screen.

Do the same for “Brand”, “Address”, “Location” and “Air pulsed burner”.

Press OK on “Tightness” line, select “B Type” (untight) or “C Type” (tight) then press OK.
Press OK on “Combust.” line, select the type of combustible for the boiler then press OK.
Press OK to tick the “Air pulser burner” box if the boiler has one.

Press the “Save” function key to save the boiler features.

The analyser backs to the list of boilers.

7.2. Modify a boiler
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The list of boilers saved in the analyser is displayed.

Go to the boiler to modify with the keypad then press OK.
Press the “Detail” function key.

Details of the boiler are displayed.

Press the “Modify” function key.

Go to the line to modify with the keypad then press OK.
The keyboard appears.

Make the modifications.

Press the “Save” function key to validate.

The analyser backs to “Modify boiler” screen.

Press the “Save” function key once all the changes have been made.

7.3. Delete a boiler
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The list of boilers saved in the analyser is displayed.

Go to the boiler to delete with the keypad then press OK.
Press the “Delete” function key.

A message appears asking to confirm the deletion of the boiler.
Go to YES then press OK to confirm the deletion.

Go to NO then press OK to cancel.
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Each saved inspection is linked to a customer. It is possible to see the details of an inspection, to add one or to delete one.
Available inspections in the analyser are the following: combustion, ambient temperature, flue gas temperature, internal temperature,

8. Manage the inspections

Flow/Return temperature, dew-point temperature, draft pressure, differential pressure, flue gas velocity, Max CO, opacity, ambient COs,
ionisation current, leak detection, gas network tightness and gas flow.
The maximum number of inspections is 10 per boilers.

8.1. Get to inspections
To find every inspections of a customer and details of this inspection, follow the specified procedure:

>

>

>

The list of customers saved in the analyser is displayed.

Go to the required customer then press OK.

Every boilers linked to this customer are displayed.

Go to the required boiler then press OK.

Every inspections linked to this customer and boiler are displayed.
Go to the required inspection then press OK.

Details of the inspection are displayed.

8.2. Create an inspection
It is possible to create an inspection for specific customer that will be performed later.

>

>

The list of customer's inspections is displayed.
Press the “Add” function key to add an inspection.
Alist of inspections is displayed.

Go to the required inspection then press OK.

The inspection is added with “Not done” mention.

8.3. Delete an inspection
To delete an inspection of a customer.

>
>

The list of customer's inspections is displayed.
Press the “Delete” function key to delete an inspection.
Go to YES then press OK to delete the inspection or go to NO then press OK to cancel.

8.4. Create a group

Groups allow to gather measurements in a folder. This function has to be activated (see page 18). To create a group:

>
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Once the measurement is finished, press the “Save” function key to save it.

The analyser displays the recorded customers list.

Select a customer with the keypad and press OK or create customer (see page 23) and select it.
The analyser displays the available boilers list.

Select a boiler with the keypad and press OK or create a boiler (see page 24) and select it.
The analyser confirms the recording is done.

Press OK.

The analyser proposes to add the measurement to a group.

Choose YES to create a group: press the “Add” function key.

Press OK to name the group.

The keyboard appeatrs.

Use the direction arrows to select letters and press OK to validate them.

Press the “OK” function key to validate the name.

Press the “Save” function key to save the group.

Press OK to save the measurement in this group.

The instrument backs to the measurement screen.

The created group appears in the inspections list:

>

>

>

Go to the “Customer” menu with the keypad and press OK.

The analyser displays the list of recorded customers on the instrument.

Go to the required customer with the arrows and press OK.

The analyser displays all the boilers linked to this customer.

Go to the required boiler with the arrows and press OK.

The analyser displays all the inspections linked to this customer and boiler and the created groups.

Manage the inspections
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» Go to the required group folder and press OK.

The analyser displays the inspection list recorded in this group.
» Go to the required inspection and press OK.

The analyser displays the inspections details.

8.5. Add an inspection to a group

The group function has to be activated (see page 18). If an inspection or a measurement is not added to a group during the recording,
it is possible to add it later:

Go to the required inspection or measurement with the arrows.

Press OK to display the details.

Press the “Add” function key to add it to a group.

Select the group to add the measurement or inspection with the arrows, or create a new group (see page 25).

Press OK to validate.

The measurement is saved in the group.
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8.6. Delete a group

To delete a group:
» Go to the “Customer” menu with the keypad and press OK.
The analyser displays the list of recorded customers on the instrument.
Go to the required customer with the arrows and press OK.
The analyser displays all the boilers linked to this customer.
Go to the required boiler with the arrows and press OK.
The analyser displays all the inspections linked to this customer and boiler and the created groups.
Go to the required group folder and press the “Delete” function key.
A confirmation message is displayed.
To confirm the deletion: go to YES and press OK. To cancel: go to NO and press OK, or press Esc key.
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9. Perform measurement of a customised procedure E.'/

Customised procedures, created by the LOGAZ-2 software (optional software), when they are transferred in the analyser can be
performed.

9.1. Preliminary operations to procedures

Before performing the measurements, names of the different customers and theirs respective boilers must be saved in the
A analyser. See page 23 to create customers and page 24 to create boilers or the LOGAZ-2 software user manual (optional
software).

9.2. Launch a customised procedure

Turn on the analyser.

Go to “Procedures” with the keypad then press OK.

Select the customer then the boiler in which measurements will be performed.
Go to “Customised” with the keypad then press OK.

The list of procedures saved in the analyser is displayed.

Select the procedure with the keypad then press OK.

The analyser displays the 1° step of the customised procedure.

Go to “Start” with the keypad then press OK.

The analyser performs the measurement.

Press OK on “Next” if the customised procedure has several step.
The analyser launches the next step.

OR

» Press OK on “Quit” if the customised procedure has only one step.
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The analyser backs to the list of customised procedures. At the end of the procedure, the analyser saves it and automatically links it to
the customer and boiler selected before launching the measurement. It is possible to get to details of this procedure in the “Customer”
menu.
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10.1. Perform a measurement of theoretical flow

10. Perform a control of gas flow H

» Turn on the analyser. Go to “Procedures” menu with the keypad then press OK.
The analyser asks to select a customer: go to “OK” then press OK.
The list of customers is displayed.
» Select the customer then press OK.
The list of boilers is displayed.
» Select the boiler then press OK.
“Procedure” screen is displayed.
» Go to “Gas flow” with keypad then press OK.
A message indicating “Step 1: Theoretical flow” is displayed.
» (o to “Next” then press OK.
“Theoretical flow” is displayed.
» Specify the power capacity of the boiler in kW (data on the information plate of the boiler): go to each number, press OK,
press the up and down arrows to increment or decrement the number then press OK to validate.
» Make the same operation to select the standard: NF or CE.
» Make the same operation to select the gas type: GAS H, GAS B, BUTANE or PROPANE.
» Press the “OK” function key to validate.

A message indicating “Step 2: Real flow” is displayed.

The theoretical flow is calculated according to a power capacity in kW of the boiler, the standard of the boiler (CE or NF standard), the
gas type (Gas H, Gas B, butane or propane) and according to a coefficient. Table below allows to calculate this flow according to the

power capacity:
Standard GAS H (19-21 mbar) GAS B (25 mbar) Butane Propane
NF Pu/KW x 2.166 Pu/KW x 2.519 Pu/KW x 0.651 Pu/KW x 0.843
CE Pu/KW x 1.927 Pu/KW x 2.241 Pu/KW x 0.579 Pu/KW x 0.750
10.2. Perform a measurement of real flow
Read a gas meter :
The measurement of the theoretical flow must be performed previously
A message indicating “Step 2: Real flow” is displayed.
» Go to “Next” then press OK.
“Start index (L)” is displayed. EE
» Specify the start flow indicated on the gas meter: go to each number, press OK,
press the up and down arrows to increment or decrement the number then
press OK to validate. ‘ ‘
> Press the “OK” function key to validate. Totaliser in m? Totaliser in litres
A message indicating “Step 2: Wait: 2 min.” and a progress bar are displayed. owliserinm
> Wait for 2 minutes. It is possible to cancel this measurement: press OK.
> (o to “Next” then press OK at the end of the 2 minutes.
“End index (L)” screen is displayed.
» Specify the end flow indicated on the gas meter: go to each number, press OK, press the up and down arrows to increment
or decrement the number then press OK to validate.
» Press the “OK” function key to validate.

A message displays the flow measurement result.

When the measurement is finished:

>

>

Press OK.
The analyser asks to save the measurement result then to print the measurement result.
Go to YES or NO then press OK.

10.3. Results interpretation
The analyser displays the flow result by the following:

OK: lower or equal to 10%
A1: between 10.1 and 20%
A2: greater than 20%
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11. Perform a gas network leak test *:3

To perform this test, it is necessary to have a gas network leak testing kit. This kit is available as option (ref; KEG).

11.1. Perform the test

>
>
>
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Connect the different items of the kit on the network to test (see user manual of the KEG).
Turn on the analyser.

Go to “Procedures” menu with the up and down arrows then press OK.

The analyser asks to select a customer and a boiler: go to “OK” then press OK.
The list of customers is displayed.

Select the customer then press OK.

The list of boilers is displayed.

Select the boiler then press OK.

“Procedures” screen is displayed.

Go to “Network tightness” with the keypad then press OK.

A message indicating “Plug silicone tube on P+” is displayed.

Plug the silicone tube on P+ pressure tap then press OK.

A message indicating “Pressurise to 50 mbar” is displayed.

Pressurise the network to 50 mbar then press OK.

A message indicating “Please wait 10 minutes” and a progress bar are displayed.
At the end of the 10 minutes, results are displayed:

e start pressure

e end pressure

* possible loss of pressure

11.2. Link the measurement to a customer

When the measurement has been performed, it is possible to link it to a customer registered in the analyser or to a customer
unregistered in the analyser that must be created.

>

Press the “Save” function button.
The analyser displays the list of recorded customers.

» Select a customer with up and down arrows then press OK or create a customer (see page 23) then select it.

The analyser displays the list of available boilers.

> Select the boiler with up and down arrows then press OK or create a boiler (see page 24) then select it.

The analyser backs to the measurement screen.

11.3. Print the results
It is possible to print the results on the ticket:

>

Press the “Print” function button.
Results are printed on the ticket.

See page 17 for the printing configuration.
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12. Perform a pressure measurement
The draft measurement allows to check if the flue of the boiler correctly clears flue gas caused by the combustion.

12.1. Perform the measurement

Connect the flue gas probe on the analyser.

Turn on the analyser.

Go to the “Measurement” menu with the keypad then press OK.

The analyser performs the gas autozero: remaining time and a progress bar display on the screen.
Go to “Pressure” with the keypad then press OK.

Go to “Draught pressure” with the keypad then press OK.

Measurement launches and the analyser displays the draft.

4 D Measurement
process of the draft
in nozzle output

VYV VYVV

Measurement

process of the
output ¥’ —_ flue pipe

Connecting

Probe

Put the probe of the KIGAZ 210 in the .
draft hocF:d, going through the front face Put the probe of the KIGAZ 210 in the Put the probe of the KIGAZ 210 in the

of the boiler nozzle output, from the beginning of the draft hood, going through the side
connecting flue openings of the boiler
12.2. Perform a differential pressure measurement

» Connect the flue gas probe on the analyser.

» Turn on the analyser

» Go to the “Measurement” menu with the keypad then press OK.
The analyser performs the gas auto-zero: remaining time and a progress bar display on the screen. The pressure
measurement remains possible.

» Go to “Pressure” with the keypad then press OK.

» Go to “Diff. Press.” with the keypad then press OK.

» Press “Auto-zero”.
Measurement launches and the analyser displays the differential pressure.

12.3. Perform a flue gas velocity measurement

Connect the flue gas probe on the analyser.

Turn on the analyser.

Go to the “Measurement” menu with the keypad then press OK.

The analyser performs the autozero: remaining time and a progress bar display on the screen.
Go to “Pressure” with the keypad then press OK.

Go to “Flue gas velocity” with the keypad then press OK.

The measurement launches and the analyser displays the differential pressure.
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12.4. Link the measurement to a customer

When the measurement has been performed, it is possible to link it to a customer registered in the analyser or to a customer
unregistered in the analyser that must be created.
» Press the “Save” function button.
The analyser displays the list of recorded customers.
» Select a customer with up and down arrows then press OK or create a customer (see page 23) then select it.
The analyser displays the list of available boilers.
» Select the boiler with up and down arrows then press OK or create a boiler (see page 24) then select it.
The analyser backs to the measurement screen.
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12.5. Add the measurement to a group

The group function has to be activated (see page 18).
Once the measurement is linked to a customer and a boiler, it is possible to add it in a group in the instrument, or create a group:
The analyser proposes to add the measurement to a group.
» Goto YES and press OK.
» Go to the required group with the arrows and press OK, or create a group (see page 25).
The analyser backs to the measurement screen.

12.6. Print the results

It is possible to print the results on the ticket:
» Press the “Print” function button.
Results are printed on the ticket.
See page 17 for the printing configuration.

13. Perform a measurement of ambient CO: ﬁ

13.1. Perform the measurement

» Connect a CO; probe (available as option) on C1 connection on the top of the analyser.
» Turn on the analyser.
» Go to the “Measurement” menu with the keypad then press OK.
The analyser performs the auto-zero: remaining time and a progress bar display on the screen.
» Go to “Ambient CO,” with the keypad then press OK.
Measurement launches and the analyser displays the level of ambient CO,.

13.2. Link the measurement to a customer

When the measurement has been performed, it is possible to link it to a customer registered in the analyser or to a customer
unregistered in the analyser that must be created.
» Press the “Save” function button.
The analyser displays the list of recorded customers.
» Select a customer with up and down arrows then press OK or create a customer (see page 23) then select it.
The analyser displays the list of available boilers.
» Select the boiler with up and down arrows then press OK or create a boiler (see page 24) then select it.
The analyser backs to the measurement screen.

13.3. Add the measurement to a group

The group function has to be activated (see page 18).
Once the measurement is linked to a customer and a boiler, it is possible to add it in a group in the instrument, or create a group:
The analyser proposes to add the measurement to a group.
» Goto YES and press OK.
» Go to the required group with the arrows and press OK, or create a group (see page 25).
The analyser backs to the measurement screen.

13.4. Print the results

It is possible to print the results on the ticket:
» Press the “Print” function button.
Results are printed on the ticket.
See page 17 for the printing configuration.
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14. Perform a measurement of Max CO co

14.1. Perform the measurement

» Connect a CO probe (available as option) on C1 connection on the top of the analyser or connect the flue gas probe on the
single connector on the bottom of the analyser.

» Turn on the analyser.

» Go to the “Measurement” menu with the keypad then press OK.

The analyser performs the autozero: remaining time and a progress bar display on the @
screen.

» Go to “Max CO” with the keypad then press OK. Py
> Press OK to launch the measurement. e,
The measurement is launched, the instrument displays the level of CO and the level of ]
Max CO.
When the measurement duration is finished, the analyser displays the value of CO
maximum during the measurement.

The default measurement duration is 30 s. It is possible to change this duration before starting
the measurement:

» On “Max CO” screen, before pressing OK to start the measurement, press the
“Duration” function key.
“Duration” screen is displayed.
Press OK.
Use the keypad to select the required measurement duration: 30 /40 /50 s or1/2/3/4 /5 minutes.
Press OK to validate the measurement duration.
Press Esc to back to the screen of measurement start of Max CO.
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14.2. Link the measurement to a customer

When the measurement has been performed, it is possible to link it to a customer registered in the analyser or to a customer
unregistered in the analyser that must be created.
» Press the “Save” function button.
The analyser displays the list of recorded customers.
» Select a customer with up and down arrows then press OK or create a customer (see page 23) then select it.
The analyser displays the list of available boilers.
» Select the boiler with up and down arrows then press OK or create a boiler (see page 24) then select it.
The analyser backs to the measurement screen.

14.3. Add the measurement to a group

The group function has to be activated (see page 18).
Once the measurement is linked to a customer and a boiler, it is possible to add it in a group in the instrument, or create a group:
The analyser proposes to add the measurement to a group.
» Goto YES and press OK.
» Go to the required group with the arrows and press OK, or create a group (see page 25).
The analyser backs to the measurement screen.

14.4. Print the results

It is possible to print the results on the ticket:
»  Press the “Print” function button.
Results are printed on the ticket.
See page 17 for the printing configuration.
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15.1. Perform a measurement of ambient temperature

>
>

>

>

15. Perform some temperature measurements

Connect a Pt100 temperature probe (available as option) on C1 connection on the top of the analyser.

Turn on the instrument

Home screen is displayed with measurement menu highlighted.

Press OK.

The analyser performs the auto-zero: remaining time and a progress bar display on the screen. However it is possible to
reach the temperature menu during the auto-zero.

Go to “Ambient Temp.” with the keypad then press OK.

The temperature detected by the Pt100 probe is displayed on the analyser.

15.2. Perform a measurement of flue gas temperature

>
>

>

>

Connect the flue gas probe on the analyser.

Turn on the analyser.

Home screen is displayed with measurement menu highlighted.

Press OK.

The analyser performs the gas auto-zero: remaining time and a progress bar display on the screen. However it is possible to
reach the temperature menu during the auto-zero.

Go to “Flue gas Temp.” with the keypad then press OK.

The screen displays the flue gas temperature detected by the thermocouple probe of the flue gas probe.

15.3. Perform an ambient temperature measurement with the internal sensor

>

>

>

Turn on the instrument

Home screen is displayed with measurement menu highlighted.

Press OK.

The analyser performs the auto-zero: remaining time and a progress bar display on the screen. However it is possible to
reach the temperature menu during the auto-zero.

Go to “Internal Temp.” with the keypad then press OK.

The screen displays the NTC temperature detected by the analyser.

15.4. Perform a Flow/Return temperature measurement

>
>

>

>

Connect 2 thermocouples Velcro type (ref. : SKV 150) or lamella contact (ref. : SKCT) probes on the Kigaz.

Turn on the instrument.

Home screen is displayed with measurement menu highlighted.

Press OK.

The analyser performs the auto-zero: remaining time and a progress bar display on the screen. However it is possible to
reach the temperature menu during the auto-zero.

Go to “Flow/Return Temp.” with the keypad then press OK.

The screen displays the T1 temperature and the T2 temperature and the delta of temperature (AT) detected by the analyser.

15.5. Link the measurement to a customer

When the measurement has been performed, it is possible to link it to a customer registered in the analyser or to a customer
unregistered in the analyser that must be created.

>

>

>

Press the “Save” function button.

The analyser displays the list of recorded customers.

Select a customer with up and down arrows then press OK or create a customer (see page 23) then select it.
The analyser displays the list of available boilers.

Select the boiler with up and down arrows then press OK or create a boiler (see page 24) then select it.

The analyser backs to the measurement screen.

15.6. Add the measurement to a group

The group function has to be activated (see page 18).
Once the measurement is linked to a customer and a boiler, it is possible to add it in a group in the instrument, or create a group:

>
>

The analyser proposes to add the measurement to a group.
Go to YES and press OK.
Go to the required group with the arrows and press OK, or create a group (see page 25).
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The analyser backs to the measurement screen.

15.7. Print the results

It is possible to print the results on the ticket:
» Press the “Print” function button.
Results are printed on the ticket.
See page 17 for the printing configuration.

Perform some temperature measurements
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16. Perform a measurement of opacity \}

It is possible to enter in the analyser from 1 to 3 opacity indexes performed thanks to opacity pump available as option.
The opacity index consists of the measurement of solid waste of combustion in the flue with a pump and a filter of measurement. The
filter coloration is compared with a table reference composed by 10 greyed areas numbered from 0 to 9.

16.1. Perform the measurement

Preliminary operation:
To avoid the condensation in the pump, it is necessary to breathe in WITHOUT FILTER fresh air before performing
a measurement.

Put the paper filter in the pump.

Pump out flue gas in the middle of the flue.

The necessary gas volume for a measurement of opacity corresponds to about 10 pump aspirations.
Compare the filter clogging to the reference table to determine the opacity index.

Make the same operation several times if necessary, replace the filter each time.

VV VYV

16.2. Enter the indexes in the analyser

When the measurement of opacity has been performed, enter the opacity indexes in the analyser:
» Turn on the analyser.
The analyser performs the auto-zero: remaining time and a progress bar display on the screen. However it is possible to
reach the Bacharach index menu during the auto-zero.
Press OK.
Go to “Bacharach index” with the keypad.
Press OK.
Press OK on “Index 1” line.
Increment the index from 0 to 9 with the keypad.
Press OK.
Repeat the procedure for 2 and 3 indexes.
The analyser indicates the opacity indexes average on “Average” line at the bottom of the screen.

VVVVVVY

16.3. Link the measurement to a customer

When the measurement has been performed, it is possible to link it to a customer registered in the analyser or to a customer
unregistered in the analyser that must be created.
» Press the “Save” function button.
The analyser displays the list of recorded customers.
» Select a customer with up and down arrows then press OK or create a customer (see page 23) then select it.
The analyser displays the list of available boilers.
» Select the boiler with up and down arrows then press OK or create a boiler (see page 24) then select it.
The analyser backs to the measurement screen.

16.4. Add the measurement to a group

The group function has to be activated (see page 18).
Once the measurement is linked to a customer and a boiler, it is possible to add it in a group in the instrument, or create a group:
The analyser proposes to add the measurement to a group.
» Goto YES and press OK.
» Go to the required group with the arrows and press OK, or create a group (see page 25).
The analyser backs to the measurement screen.

16.5. Print the results

It is possible to print the results on the ticket:
» Press the “Print” function button.
Results are printed on the ticket.
See page 17 for the printing configuration.
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17. Perform a measurement of ionisation current E

The measurement of ionisation current allows to check the presence of the flame. In standard operation, the ionisation
probe produces a currant of a few pA or a few dozen of YA. In case of lack of flame, this current is not present anymore
(measurement; 0 pA), the safety equipments of the boiler cut off the power supply.

17.1. Perform the measurement

» Connect an ionisation current probe on C1 connection of the analyser.
» Turn on the analyser.
Home screen is displayed with measurement menu highlighted.
» Press OK.
The analyser performs the autozero: remaining time and a progress bar display on the screen. However it is possible to reach
the ionisation current menu during the autozero.
» Go to “lonisation current” with the keypad then press OK.
» Connect the ends of the probe on the boiler.
The measured ionisation current is displayed on the analyser. This value must be equal to several dozen of UA.

17.2. Link the measurement to a customer

When the measurement has been performed, it is possible to link it to a customer registered in the analyser or to a customer
unregistered in the analyser that must be created.
» Press the “Save” function button.
The analyser displays the list of recorded customers.
» Select a customer with up and down arrows then press OK or create a customer (see page 23) then select it.
The analyser displays the list of available boilers.
» Select the boiler with up and down arrows then press OK or create a boiler (see page 24) then select it.
The analyser backs to the measurement screen.

17.3. Add the measurement to a group

The group function has to be activated (see page 18).
Once the measurement is linked to a customer and a boiler, it is possible to add it in a group in the instrument, or create a group:
The analyser proposes to add the measurement to a group.
» Goto YES and press OK.
» Go to the required group with the arrows and press OK, or create a group (see page 25).
The analyser backs to the measurement screen.

17.4. Print the results

It is possible to print the results on the ticket:
»  Press the “Print” function button.
Results are printed on the ticket.
See page 17 for the printing configuration.
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18. Perform a CH; measurement

There are two possibilities to perform a CHs measurement;
*  With an internal sensor (optional)
»  With a SDFG external probe (optional).

18.1. Perform the measurement with the probe

» Connect a CH, probe on C1 connection on the bottom of the analyser.

» Turn on the analyser.

» Go to the “Measurement” menu with the keypad then press OK.
The analyser performs the auto-zero: remaining time and a progress bar display on the screen. However it is possible to
reach the gas leak detection menu during the auto-zero.

» Go to “Gas leak detection” with the keypad then press OK.

» Press OK to launch the measurement.
If the probe is connected for more than 1 minute, the measurement screen appears and indicates the concentration and
places it on a bargraph.
If the probe has just been connected, the screen indicates the remaining time of warming.
The measurement begins, the analyser displays the CH, level.

18.2. Perform the measurement with the sensor

» Turn on the analyser.
» Go to the “Measurement” menu with the keypad then press OK.
The analyser performs the auto-zero: remaining time and a progress bar display on the screen.
» Go to “Flue gas” with the keypad then press OK.
The measurement begins, the analyser displays the CH, level.

18.3. Link the measurement to a customer

When the measurement has been performed, it is possible to link it to a customer registered in the analyser or to a customer
unregistered in the analyser that must be created.
» Press the “Save” function button.
The analyser displays the list of recorded customers.
» Select a customer with up and down arrows then press OK or create a customer (see page 23) then select it.
The analyser displays the list of available boilers.
» Select the boiler with up and down arrows then press OK or create a boiler (see page 24) then select it.
The analyser backs to the measurement screen.

18.4. Add the measurement to a group

The group function has to be activated (see page 18).
Once the measurement is linked to a customer and a boiler, it is possible to add it in a group in the instrument, or create a group:
The analyser proposes to add the measurement to a group.
» Go to YES and press OK.
» Go to the required group with the arrows and press OK, or create a group (see page 25).
The analyser backs to the measurement screen.

18.5. Print the results

It is possible to print the results on the ticket:
» Press the “Print” function button.
Results are printed on the ticket.
See page 17 for the printing configuration.
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19. Perform a flue gas velocity measurement with a Pitot .‘//
tube /4'
A The used Pitot tube must be a Pitot tube type L with K thermocouple connection.

< I% @ The Pitot tube must be introduced perpendicularly, in the middle into the duct and

parallel to the flow.

The head (ending with an ellipsoidal nose) must be maintained parallel and
facing the flow.

The total pressure (+) catched by the nose, is connected to the P+ at the bottom
of the analyser.

The static pressure (-) catched by the holes of the head, is connected to the P- at
the bottom of the analyser.

The connection cable of the thermocouple K probe is connected to the T1 K
thermocouple inlet of the top of the analyser.

I::> Total pressure (Tp)

» Static pressure (Sp)
Pression dynamic = Tp-Sp

If the K thermocouple cable is not connected, no value is
displayed.

When the connections are made:
» Turn on the analyser.
» Go to “Measurement” menu then press OK.
» Go to “Pressure” menu then press OK.
» Go to “Draught Press.” then press OK.
The analyser displays the measured values.

19.1. Link the measurement to a customer

When the measurement has been performed, it is possible to link it to a customer registered in the analyser or to a customer
unregistered in the analyser that must be created.
» Press the “Save” function button.
The analyser displays the list of recorded customers.
» Select a customer with up and down arrows then press OK or create a customer (see page 23) then select it.
The analyser displays the list of available boilers.
» Select the boiler with up and down arrows then press OK or create a boiler (see page 24) then select it.
The analyser backs to the measurement screen.

19.2. Add the measurement to a group

The group function has to be activated (see page 18).
Once the measurement is linked to a customer and a boiler, it is possible to add it in a group in the instrument, or create a group:
The analyser proposes to add the measurement to a group.
» Go to YES and press OK.
» Go to the required group with the arrows and press OK, or create a group (see page 25).
The analyser backs to the measurement screen.

19.3. Print the results

It is possible to print the results on the ticket:
» Press the “Print” function button.
Results are printed on the ticket.
See page 17 for the printing configuration.
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20. To get to information about the analyser n

The “Information” menu of the analyser allows to get to several information:
*  Type of analyser
*  Version of the firmware
»  Serial number of the analyser
* The adjustment date
¢ Phone and fax numbers, e-mail of Kimo Instruments
*  Options of the analyser
»  Type of sensor, its serial number and its installation date.

To get to this menu:
From the home screen:
» Go to “Information” menu with the keypad then press OK.
The information is displayed on the screen.
» Use the keypad to go from one screen to the other.

From any information screen:
» Press the “Diagnostic” function key.
The analyser displays information about sensors.

. ) ) Information
Ki > lIl Information III Information \II Information Diagnostic
MO agnostic
INSTRUMENTS . Pos 1: 02 oK
09  Serialnum: 15.09.0007
KIMO O installed on: 28/08/2015
Pos 2: CO OK
Q INSTRUMENTS “ INSTRUMENTS “ INSTRUMENTS Se  Somimm: 1807.5048
BAZ 210 KIMO MO Disgnostic O Installed on: 28/08/2015
» o Pos 3: NO oK
A A @O  Seralnim: 1508.1802
° Installed on: 28,/09/2015
Version 0.85-3282 Tel 05.53.80.85.00 Options: - Bluetooth
Fax. 05.53.80.16.81 - LOGAZ-2 Software
Serial num. 3C 15.06099999 Email kimo@kimo.fr - No contract
Adjusted on 28/09/2015
v v
information Diagnostic Diagnostio Diagnostic I
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21. Maintenance of the analyser

21.1. Life-time of the sensors

Sensors are electrochemical type: inside them, in the presence of gas to detect, a chemical reaction occurs that causes an emission of
electrical current. The electric current strength detected by the instrument is converted into a corresponding gas concentration. The
life-time of the sensor is strongly linked to the reagent consumption present in the sensor. As their consumption increases, features of
the sensor are getting worse until their exhaustion, after which it is necessary to replace it. To ensure the measurement accuracy,
sensors have to be calibrated only in Assistance centre qualified by Kimo.

Sensor Average life-time Required calibration
Long-life O, 5 years Annual
CO-H; 2 to 3 years Annual
NO 2to 3 years Annual
CH, 3 to 5 years Annual

21.2. Replace the sensors

Follow this procedure to replace a used sensor:

The analyser must be turned off.

Remove the protective cover.

Turn the analyser.

Unscrew the sensors cover with a cross-head screwdriver.

Remove the trap.

Disconnect the ribbon cable of the sensor to replace.

Rotate the sensor counter clockwise taking care not to bring pressure on the board of the sensor.
Remove the sensor.

Put the new sensor taking care to insert the two jacket hooks of the sensor in their location.

&vvvvvvvv

Exercise the rotation constraint on the sensor body and not on the electronic card. hooks

> Rotate the sensor clockwise.
> Reconnect the ribbon cable of the sensor.

Disconnection of the
ribbon cable of the sensor
to replace

Sensor rotation Remove the used
sensor

Sensors access

Maintenance of the analyser 39



Insertion of a new sensor then rotation Connection of the
of the sensor sensor ribbon cable

A Exercise the pressure on the sensor body and not on the electronic card.
Sensors have very accurate locations, see the following locations defined for each sensor:
* long-life O, sensor must be in position 1
A *  CO sensor must be in position 2
* NO and CH, sensors must be in position 3.

When a sensor has been replaced, it is possible to check the proper functioning of this new sensor by going in the “Information”
menu of the analyser. It is normal that a sensor that has just been installed gives the following message: “Current Error”, it is
necessary to wait a few time to stabilise the polarisation of the sensor.

Here are the stabilisation times for each sensor:

0O,: 48 hours

CO-Hy: 48 hours

NO: 48 hours

CH,: 48 hours

21.3. Replace the paper roll of the printer

Follow this procedure to replace the paper roll of the printer:
» Raise the upper part of the printer.
» Put the paper roll in the required location.
» Pull up slightly on the paper: it must be caught between the upper part and the lower part of the printer.
» Close the upper part.
Some paper must be out from the slot situated between the lower part and the upper part of the printer part.

Both sides of the paper are different: the brightest side is the printed side and must be facing the user.

-

|
Upper part to Paper location Introduction of Paper correctly
raise the paper roll introduced
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21.4. Replace the battery

Follow this procedure to replace the battery:
The analyser must be turned off.
Remove the protective cover.

Turn the analyser.

Remove the battery cover.
Disconnect the battery.
Connect the new battery.

&vvvvvv

Do not pull the cable, unplug softly the connector.

Unscrew the battery cover with a cross-head screwdriver.

Maintenance of the analyser
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22. Calculations of the different parameters
22.1. CO, NO and NOx conversions
co[ ™. 1=C0[ ppm x1.24922
mg’
NO[-9.|=NO[ ppm]x1.33845
mg’

NO,[ ™. 1=NO [ ppm] x2.05229
mg’

Conversions on units are the same for both gases. CO is taking as an example.
0 reference (Ox) is only linked to CO and NO.

}\‘_ COZmax_ 21

~ CcOo, 21-0,

co[-M9 CO[mg])\#
kWh PCIx0.277778

9 1_cor™ Vi
COL 1= COL 1% Biers277778 X001

9 1_cor.m9 Vi
COL571=COln ™ Bena27777g X000

mg/m ﬂ 2] O2ref
Co[ 0. |=CO[—]x 1-0

ppm 21-0,
CO[OM] CO[ppm]x 2120,

CO[%]=CO[ ppm] x0.0001

2|8

CO[mi] CO[ 9 1%0.001

With:

Oqr a reference value selected by the user, this value has to be entered in the device in %.

0O, oxygen value measured in %.

Ve the theoretical volume of flue gas in m® (given in the table of coefficient)

NCV the net calorific value in MJ (given in the table of coefficient)

COzmax the maximum level in % in carbon dioxide of flue gas dry products (given in the table of coefficient)

22.2. Calculation of the level in NOx

NO —0—;)7 with NO the level in nitrogen monoxide in ppm.
0.97 if the %NO; is at 3% in the “Setting” menu.
0.95 if the %NO.is at 5% in the “Setting” menu.
So for the measurement of the NO and NO,
NO,=NO+ NO,

22.3. Calculation of flue gas velocity

V:k\/ZAP

MVF
With:
» k: coefficient of the differential pressure item
» AP differential pressure (dynamic pressure).
» My mass density of the flue gas (already calculated for the calculation of the higher efficiency).
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1. Introduction

LIGAZ-2 software, supplied with the gas analysers of the KIGAZ range, allows to set the analyser, to create and give information a
customers, boilers and inspections database, to process and download measurement datasets.

2. Software installation

2.1. Recommended minimum configuration
For the proper functioning of the software, the following minimum configuration is recommended:
*  Operating system: Windows, XP, VISTA, 7
e Communication port: USB 2.0
« DVD player
*  RAM memory: 1 GO
*  Disk memory: 1 GO

2.2. Installation

> Put the DVD into the player of the computer.
It automatically starts. If not, go to “My computer”, double-click on DVD drive then on “SetupLIGAZ-2" icon.
»  Follow the indications of installation.

Setup. i Setup ] Setup [

LIGAZ-2 Setup Wizard
Welcome to the LIGAZ-2 Setup LIGAZ-2 Setup Wizard et Frame::rk iza
Wizard L1GAZ-2 Software r

INSTRUMENTS

This wil instal LIGAZ-2 an your computer, WARNING :

If a device is currently connected to the
computer, unplug it

You will be able to connect it when the
complete installation of the application is
finished.

It recommended that you dose sl other applications before
contining.

Setup steps :

Click Next to continue, or Cancel to exit Setup. net Framework.

I:l Diiver KIGAZ
D LIGAZ2 Software

Ciick next button to star sehup

LIGAZ-2

¥ ueaz-2 = ) Setup. e Setup [
Welcome to the LIGAZ-2 Setup Wizard ', LIGAZ-2 Setup Wizard LIGAZ-2 Setup Wizard
ﬁ'ﬁ ) LIGAZ-2 Software Criver KIGAZ
| R
=

The installer il quide po tiough the steps required o install LIGAZ-2 on your computer.

Setup steps : Setup steps :

net Framenork.
et Framewark,

Diiver KIGAZ

DiverKIGAZ =
LIGAZ 2 Software ] PR [ ]usz2sohuae
WARNING: This compulerprogram i potected by cospightlaw and itematinal eates
Unasihorzed duplcaion o disrbion of s progtam; orary pattian of . may tesu n severe vl
orcimingl peralies, and wil be oseeuitzd 0 the masim.m exent possible under the ko,
LIGAZ-2 Click next button to start sstup LIGAZ-2 SEekhed il o el alin

) ucaz-2 =]

) ucaz2 Lo o o) Setup UL
y (@) i AT
Select Installation Folder w@’“ & Installing LIGAZ-2 o Completing the LIGAZ-2 Setup
2 G ‘_‘Q Wizard

INSTRUMENTS

The instaler wil install LIGAZ2 to the following folder. Setup has finished instaling LIGAZ-2 on your computer.

LIGAZ-2 is being installed.
Toinstal in this folder, click "Mext”. To instalto a diferent folder, erter it below of click "Browss". Click Finish to exit Setwp.

Please wal.
Folder I ]

C:\Program Files [+8E]WIMO Instruments\LIGAZ-2Y Browse. .

Install LIGAZ-2 for yoursef. or for anyone who uses this compter:

® Eveyone

© Just me

o) [Cepee ] o] R e
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3. Start with the software

After double-clicking on the o software launching icon on the desktop, the homepage of the software opens:

15

File Database KIGAZ _Options ndows ?  Connect device

2 a8 480

 UGAZ 2. 198

3 LGAZ-2
3 ~ v19812

Connection Downlosding
Detabase Setting

Please select an option in the menu

3.1. Meaning and functions of the menus bar (1)

> File
» Back to homepage: reduce all the opened windows
» Save database: save the database into the computer

* Import database: import a LIGAZ-2 or LOGAZ-2 (optional software) database saved into another computer

*  Quit: close the software
» Database
» Total: opens the total database window (Customers, boilers and performed inspections)
*  Customers: opens the customers database window
» Boilers: opens the boilers database window
» Database setting: opens the saving setting window of the database (location and recurrence)
> KIGAZ
* Downloading: allows to download data saved in the analyser and the instrument setting
«  Setting: allows to set different parameters (autozero, combustibles, references...)
» Customers / boilers deletion...: allows to delete customers and/or boilers saved in the analyser

» Comparison of PC elements with KIGAZ...: allows to compare information on customers and boilers between the

LIGAZ-2 database and the analyser

» Options

«  E-mail: allows to set parameters to send emails

»  User: information about the user

* Languages: allows to select the software language (French or English)
» Windows: allows to go from one window to another
> 7

» User manuals: allows to get to software and analyser user manuals

* Hotline: allows to get to the address and fax and phone number of the company or send a report to the after sales

service
* About: indicates software version and database version

> Device connection: indicates the connection state of the device connection. “Connect device” or “Device connected”.

Start with the software
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3.2. Meaning and functions of tool bar buttons (2)

#% | Back to homepage: closes all the opened windows il, Opens the boilers database window

3 Opens the complete database window

(Customers, Boilers, Inspections) g\ Opens the analyser download window

.', Opens the customer database window 9° | Opens the analyser setting window

3.3. Meaning and functions of the homepage buttons (3)

Allows to connect the analyser to the software A Allows to connect the analyser and access the
= = inspections unload window
ilw Allows to access the complete Qatabase: ¢ & | Allows to access the analyser setting
Customers, boilers and inspections

4. Download inspections

Inspections stored in the analyser can be downloaded on the computer:
» Connect the analyser to the computer thanks to the supplied USB cable and turn on the analyser.
» Launch LIGAZ-2 software.
» Connect the analyser to the LIGAZ-2 software clicking on the homepage button.
The software indicates that connexion is successful. o=

»  Click on the download homepage button g\
Or e
»  Click on “KIGAZ” menu then on “Downloading”.

Or

»  Click on the download icon of the tool bar g~
The software recovers inspections contained in the analyser. This operation can take a few minutes.
At the end of the recovery, the following window is displayed:

alatsln]

KIGAZ 110

» Tick the boxes corresponding to the inspections to download on the computer. To delete an inspection from the instrument,
tick the “Delete” box. To download an inspection to add to your database and delete it from the instrument, tick both boxes.
> Click on the Download selected inspections | button.
A message indicates that the transfer started, then the message “Transfer done” is displayed: the dataset has been
downloaded successfully.
» Click on OK.
The “Complete database” window is displayed with the new inspections downloaded.
Customers and boilers linked to the downloaded inspections are added to the “Customers™ and “Boilers” databases.
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5. Use the different databases

Databases are used to give information about features of boilers and customers. LIGAZ-2 software allows to recover customers and
boilers created in the analyser and allows to transfer customers and boilers created with LIGAZ-2 software in the analyser.

» Launch the software by double-clicking on the 0 icon in the desktop.

» These databases are saved in the hard disk of the computer. See page 50 for the “Database settings”.
5.1. Use the customer database

» Click on the ]. button of the tool bar or click on “Database” menu, then on “Customer”.

The following window is displayed:

Customers Details

nnnnnn

aaaaaaa

The fields are not accessible.
The customer list created on the device are displayed on the left of the screen.

> To add a customer, click on the Agd customer | button.
The fields become accessible.

» Fillin the different fields. The “Name” field is required.

> Tosaveit, clickonthe [  save customer | button.
A confirmation message is displayed.

» Click on OK.

The created customer appears in the list on the left of the screen:

nnnnn

e
wwwwwwwwwwwww

nnnnnnn

» Repeat the procedure to add other customers.
» To transfer a customer to the analyser, select it on the customer list on the left of the screen and click on the following button:

Send 1o device |. If it is inaccessible, check the device connection.
A message confirms the successful transfer.
> Click on OK.

» To download customers from the analyser to the software database, it is necessary to download inspections present on the
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device (see page 54). Only the customers linked to an inspection are added to the “Customers” software database. The
boilers linked to this customer are also added to the “Boilers” software database.
> To delete a customer, select it in the customer list and click onthe [5]  pelste customer | button.
A confirmation message is displayed:
> Click on YES to confirm the deletion, or on NO to cancel.
» Click on the Close | button to close the window and back to the homepage or on the Back 1o database
button to access the complete database.

5.2. Use the boilers database
Each customer can have several boilers.

.

» Clickonthe ™ | tool bar button, or on “Database” menu then choose “Boilers”.
The following window opens:

© File Datsbase KGAZ Options Windows 7 Analyzer connected -8 x

= -
LIRS AR
Add boller - Customer - e
a  “Moda
b
EEEEEE Brand
CCCCCCCCCCCCCCC
erial Power (kW)
* Evacuation mode
@ B type (No Leakproof) Ciype (Leakproof)
Browse.. Automatic
........
Using burner. (=] Delete bumer
ciy
]
- Requird fields
B Dol boil = = ST,
Back to database Send to device | o |

All the fields (type, model, power...) are inaccessible and the “Browse” button is inactive.

> To add a boiler, click on the adgbollen | button.
The fields become accessible and the Browse.. | button is active.
»  Fillin the different required fields (customer, model, power in kW and combustible) as indicated below.
> Click on the Browse.. | button in front of the “Customer” field to link the boiler to a customer.
The following window is displayed:
) Database : Customers [E=TRCAT X ]
[oews
Add customer * Name -
ABsb ABab
BCC First name:
o
ot
E-Mail
* Required fields
[5)  Delete customer = Sava customer
Select customer Cancel
» Select the required customer in the list on the left then click on the Selsct customer | button.

The software back to the previous screen.
» Fillin the “Model” and “Power” required fields.

» Click on the Browse.. | button in front of “Combustible” and select the combustible type of the boiler.
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The following window is displayed:

- .
Database : Combustibles I=REE X
) ustble: s
Add combustible Combustible : Energy
Saharafos Nt gas Sahara/Fos Nat. gas GAS -
Groninguen Mat. gas A1 coefficient : A2 coefficient :
Russial... Nat. gas s B
Propane
;36 B coefficient : K coefficient k :
ane
1| Light ot 0 047
Heswy fusl oil C0O2max coefficient CO2Max VF coefficient :
|| cannel-coal - -
Lowe volatils coal mes 935
Coke gas VA coefficient : AC coefficient :
Biofuel 5%
Wood 20% 13 169
Hog fuel 21%
| Peliet 52 PCI coefficient
389
[5]  Delete combustible | bl save combustibie |
Cancel | Select combustible |

> Select the combustible used by the boiler and click on the Selectcombustible | button.
15 types of combustible are programmed. If the combustible type used by the boiler is not available in the list, click on the

Add combusible |button, fill in the fields, click on the kel  save combusiivie | button then on the Select combustible
button.
> To save the boiler, click on the ki Save boller | button.
The software displays a confirmation message.
» Click on OK.
The created boiler appears on the list on the left of the screen:
I RN
[ oot |

a
6
fa
MODELE

CHIX180 CHALIDERA

Serial number * Power (kW)

0
* Evacuation mode
® Btype (No Leakproof) C type (Leakproof)

* Combustile : Gaz Nat. Sahara/Fos Browse. Automatic

[F13
[F3
Lastinspection date ouoi1se  [Hv

Using burner.. | (5] Delete bumer

a Datata boler =] Savs bol
Back to database Sond to device | Close |

» Repeat the procedure to add other boilers.

» To transfer a boiler to the analyser, select it on the boilers list then click on the Send o devics | button. If it is not
accessible, check the device connection.

A message is displayed to confirm the transfer:

» Click on OK.

» To download boilers from the analyser to the software database, it is necessary to download inspections present on the
device (see page 54). Only the boilers linked to at least an inspection are added to the “Boilers” software database. The
customer linked to this boiler is also added to the “Customers” software database.

> To delete a boiler, select it on the boilers list then click on the = Delets boiler | button.

A confirmation message is displayed.

» Click on YES to confirm deletion or NO to cancel.

» Click on the Close | button to close the window and back to the homepage, or on the Bach to dutabass
button access the complete database.
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5.3. Complete database
This database allows to have a global view of all customers and their boilers with also the inspections.

» Click on the ltool bar button or directly on the ib, button on the homepage.
Or

» Click on “Database” menu, then choose “Complete”.
The following window is displayed:

@ File Datebase KIGAZ Options Windows ?  Analyzer connected -8 x

EIE R Y IRERY

Database Customers
0 Name Firstname Address Address 2 Address 3 Phone 2
= Database =
i ABab
&, ?EC Dupont  Jean 5 rue du Gaz 0102030405 £
e
44 veis Warm Fascal Rue du Four 0123456789 B
= =

Ba
e caki
ry
| Il

Boilers
=& Dupont Jean Model Brand  Seralnumber Power Address Address2 Address3 Local Dateoflastsweeping Lastinspection date  Firstoperating date  Combustible Burner brand
CHAUDERA CHX150
B MODELE a 0110111960 Gaz Nat. SaharafFos
& Warm pascal a 24 20/11/2015 15:47:00 Gaz Nat. Groningue
b 23 201172015 15:57:00 Gaz Nat. SaharaiFos
WODELE 150 03112015 16:05:24 0312015 16:05:24 031112015 16:05:24 Gaz Nat. SaharaiFos
CHAUDERA CHX160 12345 160 4ruedelaBiche Périgueux OB/DBI2015 17:10:03  11/09/2015 17:10:03 0S/0S/2015 17:10:03 Bois 20%
4 i ] v
Inspection N°  DateJ Hour Intervention type Planification tranfered ~ Done  Delete

Summary

S rmtts 2101 158 St T~

1510000010007 201/2015 15:57:00 Sealing network

Date / Hour 20/11/2015 16:08:00
5100000100006 20/11/2015 15:48:00 Combustion analysis Delete 3

PrOVIGWS ervsesssssissssississssississssisssssssssans
5100000100005 20/11/2015 15:47:00 Opacity measurement Delete

Start pressure:
5100000100004 20/11/2015 15:47:00 Differential pressure Delete Measurement 0 mbar

15100000100003 20/11/2015 15:47:00 Flue gas temperature Delete End pressure -
5100000100002 20/11/2015 15:47:00 Ambient temperature Delete Measrement Ombar
Network airthighiness -

15100000100001  20M1/2015 15:46:00 Ambient temperature Delete

DRREERERER
IS SNSRI RSN

=]
&
2
w

Measurement. 0 mbar : Conforme
1501423100001 26M0/2015 17:05:00 Ambient temperature Delete
29(10/2015 08:00:00 Attestation SOLID Delete

Measures

> To delete an inspection from the complete database, click on the ekt |button of the inspections list.
A message is displayed to confirm deletion.
» Click on “OK” to confirm or “Cancel” to cancel the inspection deletion.

5.3.1. Database settings

» Click on “Database” menu then on “Database settings...”.
The database configuration window opens. Dataiase setings =]
» Click on the Browse. button and define the save folder path. il el

» Select the recurrence, that is the automatic registration of the database: — —
»  Select the database registration frequency: from 1 to 30 hours or 1 to N

30 dayS |1 | Howrs

Or | @ When closing software . |
» Tick “When closing software” to save automatically the database when : "

the software is closed. | e —= |

5.3.2. Save while using

To guarantee information saving, you shall regularly proceed this way:
» Click on “File” menu.
» Click on “Save database”.

5.3.3. Import a database

When opening LIGAZ-2 software, to recover a database:
» Click on “File” menu.
» Click on “Import database”.
» Go to the saving folder of the database, select the database to open then click on OK.
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5.4. Edit an analysis report

From the complete database screen, it is possible to edit a measurements report.
> Inthe menu on the left of the screen, click on the required boiler for the report edition.
» Click on the Measures | button.

The analysis report is displayed:
0 . eiz2: 15812 Mew o) I | T )

@ File Database KIGAZ Options Windows ?  Analyzer connected -

ﬂ 1 L5 Mﬂ
glPaqe:l,llM

Analysis Report

N = of intervention 15100000100008

SPONSOR Address

caki

mn

Facility Address (IF DIFFERENT)
Boiker location

BOILER IDENTIFICATION

Brand Model b Energy Gaz MNat. Sahara/Fos

Exhaust mode (AIR-TIGHT / NON AIR TIGHT) No Leakproof
Serial number {IF AVAILABLE) Commissioning date Power rating 23 KW
Last maintenance date (IF AVAILABLE) 20/11/2015 Last sweeping date (IF APPLICABLE AND AVAILABLE)

FORCED DRAUGHT BURNUER IDENTIFICATION (IF APPLICABLE)

Date Brand Model

MEASURMENT DEVICE USED

Brand KIMO Reference KIGAZ 110

MEASUREMENTS DONE

Flue gas 0, CO Max [ Ambient CO
Flue gas CO Ambient CO,

Flue gas CO, Internal temperature

Ambient temperature. Quigeing temperature

> Use theﬂl button to zoom in or zoom out on the report.
> Clickonthe L& button to print the report or on the El button to export it in PDF format.
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6. Set the analyser

LIGAZ-2 software allows to set the analyser. It is possible to:
* setthe combustibles
» set the references (O reference, altitude, atmospheric pressure)
» set the operators
» setdate and time
» get details about sensors (State and serial number)
» set the header of printing
* see the battery level
» getinformation about the analyser, update it and send report to after-sales service

Connect the analyser to the computer with the supplied USB cable.

Connect the analyser on main power thanks to the supplied adapter to avoid extinguishing of the analyser (low battery).
Click on “KIGAZ” in the menu bar.

Go down to “Setting” then click on the parameter to modify.

or - Setting

Click on the ﬂ tool bar button or directly onthe ~ € g | button from the homepage.

“KIGAZ settings” window opens. o

YV VYVVYVY

Changing parameters of the analyser has consequences on performed measurements and on the analysis
calculation. Only a qualified technician is empowered to change the parameters of the device.

nnnnnnnnnnn ]

KIGAZ 110 1C 15.10.00007 Analyzer connected.

6.1. Change the combustibles

This window allows to change the list of combustibles programmed in the analyser. It also allows to modify features of each
combustibles.
“KIGAZ settings” window is open on “Combustibles” or click on the & Combustivles | button.
» Click on the “Energy” field and select the combustible type: solid, liquid or gas.
» Double-click on one of the combustible features to modify.
> Enter the new value for the feature.
> Clickonthe  cmowsnies.. | button to send modifications to the analyser.

6.2. Change the references

This window allows to modify the O, reference (percentage of oxygen in the air which the analyser is used), the altitude (altitude in
which the analyser is used) and the atmospheric pressure (pressure in which the analyser is used).
“KIGAZ settings” window is open on “References” or click on the 8 References | button.
»  Click on the field to modify.
»  Write the new value.
» Click on the marsterrererances.| button to send modifications to the analyser.

6.3. Manage the operators

This window allows to add, delete or modify an operator.
“KIGAZ settings” window is open on “Operators” or click on the T4 oOperators | button.
» Inthe “Name” column, click on the field to write an operator name.
» Click on the Transteroperaters...| button to send modifications to the analyser.
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6.4. Modify the date and time

This window allows to de sync the analyser time and the computer time.
“KIGAZ settings” window is open on “Date / Hour” or click on the & patesHour | button.
» Clickonthe setoncaume.. |button to adjust analyser time to computer time.

6.5. Sensors state

This window allows to access the sensors features of the connected analyser.
“KIGAZ settings” window is open on “Sensors” or click on the & sensors | button.
» The displayed features are:
»  Type of sensor (CO, NO,...)
» State of sensor (connected, not connected...)
»  Serial number of the sensor

6.6. Set printings

This window allow to enter the 4 header lines of the ticket printed by the analyser.
“KIGAZ settings” window is open on “Printing” or click on the & Printing | button.
> Enter the required text in “Header line 1, 2, 3 and 4” lines.
» Clickonthe _ semss. | pytton to send modifications to the analyser.

6.7. Battery level

This window allows to see the battery level of the analysis. The analyser must be turned on and on battery.
“KIGAZ settings” window is open on “Battery level” or click on the [ Baterylevel | button.
The software displays the battery level.

6.8. Access to information about the instrument and update the instrument

6.8.1. Access to information about the instrument

“KIGAZ settings” window is open on “Information” or click on the & nformation | button.
The following information is displayed:
Product code: ex: KIGAZ 310
Serial number: ex: 00.01.2057
Firmware version: ex: 0.92
e Build: ex; 1247
It is possible to give an inventory number to the device (number selected and given by the user):
» Click on “Inventory number” field and enter the desired number.

6.8.2. Update the device
It is possible to update the firmware of the analyser, it means the internal software that allows to the analyser to work properly. It

is also

possible to install a 3 language.
» Click on KIGAZ menu then go to Settings and click on Information, or click on the ﬂ tool
bar button then on the § mformation [button.
The “KIGAZ settings” window is displayed.
» Clickonthe peviceHoine. | hytton.

The following window opens:

sssss

nnnnnnnnnnnnn

» Clickonthe  etmerast | button.
firmware _.

Connection parameters

The connection parameters window opens:
Two choices are then possible:

* The Internet connection is not protected by a proxy Urenone
» Click on Ok button on the connection parameters window.

If you are connected 1o Intemnet with a
have to identify (or Cancel)

proxy. you

Ok

A progress bar is displayed then the available firmware number is displayed.

> Clickonthe e he deviee. | DUtEON.

The update lasts for a few minutes.

»  Turn off then turn the device.
A black screen with a progress bar are displayed (see opposite) then It turns off itself.

» Turn on the device then go to “Information” menu of the analyser to check if the update has been taken into
account.

Set the analyser
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* The Internet connection is protected by a proxy
Address and serial number of the proxy, user name and corresponding password must be entered.

To get them into Windows 7:

YV VY

Click on “Start” (1) then on “Control panel” (2).

In “Control panel” window, click on the up right on “Large icons” in “View by” (3).
Click on “Internet Options” (4):the “Internet Properties” window opens.
Click on “Connections” tab (5) then on “LAN settings” button (6): the “Local Area Network (LAN) Settings” window

opens with the information about the proxy server (7).

‘earch |

E Adobe Photoshap C53

@ O BOUROCHER Romain
@ Microsoft Office Word 2003 | Documents

Eera
ﬁ OpenDffice.org 3.0 s
Music
Q} LoGAZ
# Computer
OpenDffice.org Draw 3

Control Panel 2
J LIGAZ
- Devices and Printers
FileZilla

5 Default Programs
Xl Microsoft Office Excel 2003 3

@ KILOG RF

> AllPrograms

Help and Support

Shut down | ¥ |

4" Internet Properties

General | Security [ Privacy [ Content | Connections  |programs | Advanced| [

.:9 To set up an Internet connection, dick Setup
Setup.

Dial-up and Virtual Private Network settings ———————————————

Add...

Remove...

Settings

Set default

Local Area Network {LAN) settings

LAN Settings do not apply to dial-up connections LAN settings

Choose Settings above for dial-up settings.

\~14

(63 » Controlanel » AllConrol Panel kems »

I Adjustyour computer’s settings

¥ action Center

P CinePlayer DVD Decoder
Options (32-bit)

Administrative Tools
E‘ Color Management
© oefauitprograms @ Desktop Gacgets

@ Ease of Access Center Flash Player (32-bit)
@ HomeGroup

{5y Location and Other —
Y4 sensors N 4

2 Indexing Options

B rersonalization &3 Phone and Modem

: RemoteApp and Deskto
P Region and Language [% Curnec\iupnps 2
@ Sync Center 84 sysem

£y Windows Anytime B

_ Tl 3 windows Cardsace

Adobe Version Cue CS3 @ AutoPlay

¥
(32-bit) S & Backup and Restore

@ Courrier (32-bit] @ Credential Manager

Date and Time

) veice Manger

|

i) Devices and Printers Display

JZ Folder Options A Fos _]\[ Getting Started

Interne: Options 4 &| Java 32-bit @ Keyboard

H& Netviork and Sharing Notfiation Arcalcons [ PeTormanee nformaton
Center = } and Tools

B Power Options [l Programsandeatures & Recovery

@ Software Updates (32-bi) (@) Sound G speech Recognition

B reskbar anc start Menu Troubleshcoting

84 windows Defender

8B ser accounts

B Windows Firewal ) windows update

e e N

Automatic configuration

Automatic configuration may override manual settings. To ensure the
use of manual settings, disable automatic configuration.

Automatically detect settings

D Use automatic configuration script

7 Address

Proxy server

Use a proxy server for your LAN (These settings will not apply to
dial-up or YPN connections),

Address:  10.25.221.11 Port:  B0A0

[¥]Bypass proxy server for local addresses

» Copy the address and the port in the “Address” line of the connection window as follows: 00.00.000.00:0000

Addess \P_JFT)

» Enter the user name and the corresponding password: data entered at the starting of the computer when the user logins.

> Click on the Ok button.

> Click on the ul"1@@'”'3"“*""""=‘=---| button.

The update lasts for a few minutes.
Turn off then turn on the device.

v 1.00
Upgrade from 5D
Erase FLASH
Write FLASH

A black screen with a progress bar are displayed (see opposite) then the device turns off itself.
Turn on the device then go to “Information” menu of the analyser to check if the update has been
taken into account.

6.8.3. Install a 3" language
Select the language to send in the drop-down list box.

Click on the SWHS#_EDBW| button.
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6.8.4. Send a report of the device to the After-Sales Service

> Clickonthe  SendreportioHtine.. | button.
Kimo after-sales service will receive a report about the general state of the device only readable by the after-sales service.

6.8.5. Back to factory parameters

It is possible to set the device with the factory parameters.
The “Settings” window is open on “Information”.
> Clickonthe  Backmotacioryseings | button.
The device is now set with the factory parameters.(see the factory parameters page Error: Reference source not found).

7. Options

7.1. E-mail
This option allows to set the email sending parameters in order to send report to the after- E-bail =]
sales service. E-mail address of outgoing mail
» Click on the “Options” menu then on the “Email” sub-menu. Cutgeing mal server (SMTP)
The following window is displayed: —
» Fillin the different fields: HTML :
* Email address of the outgoing mail: e-mail address of the sender Advanced options.
(p.durand@orange.fr)
*  Outgoing mail server: server address used to send e-mail (ex: smtp.orange.fr). g | — |

*  Mail format: plain text or html
» Advanced options: by clicking on the  aavanceaopions.. | button, the email setting window opens and allows to set the
SMTP outgoing server. This information is delivered in the subscription documents of the Internet access provider

> Click on the Ok button.

7.2. User information - =
This option allows to give information about the software user. o

» Click on the “Options” menu then on the “User” sub-menu. s 2

The following window is displayed: wid

> Fillin the different fields. o

» Click on the ok button. Fan:

7.3. Change the language oo

Browse ﬂ

This option allows to change the interface language.

» Click on “Options” menu. e i

» Click on “Languages” sub-menu.

» Select the required language.
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8. Customers / Boilers deletion of the analyser

It is possible to delete customers and/or boilers saved in the analyser via the LIGAZ-2 software.
» Connect the analyser to the computer then detect it with the LIGAZ-2 software.
» Click on “Menu” then “Customers/boilers deletion...”.
The following windows opens:

Customers / Boilers deletion. @

KIquz ?’]0 JC‘ 15 fom’] ......................................................................

Customers : Bailers :

Anthenin DUCRASSE
Baptiste DEMMERLE
Benjamin CHALUPRADE
Benoit VIDAL

[[] ThemaClassic DUVAL
[[] ThemaCondens DUVAL
[[] ThemaFlus DUVAL

Bryan CRANSTON
Chares BILLOT
Clément MICOLAS

Eril: LE ROUGE

Fanfan LA TULIPE E] E]
Ferdinand BARDAMU
Freddy MERCURY
Gaston LAGAFFE
Gengis KHAN

Grégory CARILLC

T =

Grigori RASPOUTINE
Guillaume MACIEL
Jean-Jean CORNU
Joe DASSIN

N it e e

Select &l

Close

To delete a customer from the analyser:
> Tick the box of the customer to delete then click onthe [=]  button between “Customer” and “Boiler” columns.
A message of confirmation is displayed. —_—
» Click on “Yes” to confirm the deletion.

To delete a boiler on the analyser:
» Click on the line of the customer to whom the boiler to delete is associated.
> Tick the box of the boiler to delete then click on the button on the left of the “Boilers” column.
A message of confirmation is displayed. S
Click on “Yes” to confirm the deletion.

A Inspections linked to the deleted customer or boiler are also deleted.
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9. Compare the instrument and software information

As we have seen, the LIGAZ-2 software allows to send information to the analyser or to delete information from the analyser:
»  Sending customers or boilers to the analyser
*  Download customers/boilers/inspections from the KIGAZ to the software
»  Delete customers and boilers from the analyser

The “Comparison of PC elements with KIGAZ” function in the KIGAZ menu allows to update customers and boilers information in
the analyser and in the LIGAZ-2 software databases. There are different possibilities.

Inspection deletion (see page 46)

<l
|

Send a customer or a boiler to the device (see page 47)

-l
-

Customers/hoilers deletion (see page 47)

<l
|

Customers/hoilers/inspections downloading (see page 46)

Comparison of PC elements with KIGAZ

A

9.1. Add elements automatically in the databases

The LIGAZ-2 software will add automatically customers and boilers in the following cases:
» Ifthe same customer is present in the analyser and the software “Customers” database but different boilers are associated
to this customer, the software will add automatically the missing boilers in the “Customers” and “Boilers” databases.
» Ifacustomer is present in the analyser with at least one associated boiler, the software will add it automatically in the
“Customers” and “Boilers” databases. But if a customer is present in the analyser without associated boiler, the software
will not add this customer in the “Customers” database.

Procedure:
» Click on “KIGAZ” menu.
» Click on “Comparison of PC elements with KIGAZ”.

9.2. Modification of customer and boilers features

The LIGAZ-2 software will compare the information: if a customer or a boiler is present in the analyser and the database but with
different features, the software will ask which features have to be taken into account.

Procedure:
» Click on “KIGAZ”.
» Click on “Comparison of PC elements with KIGAZ”.
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The following window opens:

Synchronization PC <-» KIGAZ,

Required synchronization:

() Synchronize data of the PC and KIGAZ
() Do nothing (keep the data as they are on the PC and KIGAZ)

Which data you want to keep?

PC data KIGAZ data

BLANC ALAIN - BLANC ALAIN -
Adresse - 12 RUE DU SOLEIL ‘ | Adresse : RUE DU SOLEIL ' ‘
LIEU DIT OUEST 24700 SAINT REMY SUR  [|=| | LIEU DIT QUEST 24700 SAINT REMY SUR | =
Tel : 0553808500 | | | et u553808500 '
E-Mail ml

-

Apply this choice for other tems to synchronize.

[ ¥

To keep the data as they are on the PC and KIGAZ:
» Tick the “Do nothing (keep the data as they are on the PC and KIGAZ)” box.
» Click on the “OK” button.

To update the information:
» Tick the “Synchronise data of the PC and KIGAZ” box.
» Tick the boxes of data to keep.
» Click on “OK” button.

6 To do the same actions on the following data, tick the “Apply this choice for other items to synchronise” box.
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Once returned to KIMO, required waste collection will be assured in the respect of the environment in accordance to guidelines relating to WEEE.
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